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Microsoft FSLogix Profile Container Setup with Nutanix Frame
Before we dive into FSLogix as a solution please check out this Nutanix Frame blog about user profiles:

Windows User Profiles in a Frame World

April 27, 2021

Overview

Microsoft FSLogix is a set of solutions that enhance, enable, and simplify persistent and non-persistent
Windows computing environments. FSLogix solutions are appropriate for virtual environments in both
public and private clouds. Additionally, FSLogix can enable greater portability of computing sessions.

FSLogix solutions include:

Profile Container
Office Container
Application Masking
Java Version Control

What you can do with FSLogix solutions:

Maintain user context in non-persistent environments

Minimize sign-in times for non-persistent environments

Optimize file 10 between host/client and remote profile store

Native (local) profile experience, eliminating many compatibility issues with solutions using
visible redirection, such as User Profile Disk (UPD)

Simplify the management of applications and 'Gold Images'

Specify the version of Java to be utilized by specific URLs and applications

Key capabilities

Redirect user profiles to a network location using Profile Container. Profiles are placed in VHD(X)
files and mounted at run time. It's common to copy a profile to and from the network when a
user signs in and out of a remote environment. Because user profiles are often large, sign-in and
sign-out times often become unacceptable. Mounting and using the profile container on the
network eliminates delays associated with solutions that copy files.

Redirect only the portion of the profile that contains Office data by using the Office Container.
Office Container allows an organization already using an alternate profile solution to enhance
Office in a non-persistent or persistent environment. This functionality is helpful with Outlook
.OST files.

Applications use the profile as if it were on the local drive. Because the FSLogix solutions use a
Filter Driver to redirect the profile, applications do not recognize that the profile container is
stored on the network. Obscuring the redirection is essential because many applications will not
work correctly with a profile stored on remote storage.

Profile Container is used with Cloud Cache to create resilient and highly available environments.
Cloud Cache places a portion of the profile VHD on the local hard drive. Cloud Cache also allows


https://www.nutanix.com/blog/windows-user-profiles-in-frame-world
https://www.nutanix.com/blog/windows-user-profiles-in-frame-world

an administrator to specify multiple remote profile locations. The Local Cache, with multiple
remote profile containers, insulates users from network and storage failures.

e Application Masking manages access to an application, font, printer, or other items based on
rules. Access can be controlled by various areas, by user, IP Address range, or other criteria.
Application Masking significantly decreases the complexity of managing large numbers of gold
images.

e Profile Container and Office Container do not provide any profile conversion functionality.
Operating systems that share a profile version should be able to share a single user profile.

Requirements
You are eligible to access FSLogix Profile Container, Office 365 Container, Application Masking, and Java
Redirection tools if you have any of the following licenses:

Microsoft 365 E3/E5

Microsoft 365 A3/A5/ Student Use Benefits

Microsoft 365 F1/F3

Microsoft 365 Business

Windows 10 Enterprise E3/E5

Windows 10 Education A3/A5

Windows 10 VDA per user

Remote Desktop Services (RDS) Client Access License (CAL)
Remote Desktop Services (RDS) Subscriber Access License (SAL)

FSLogix solutions may be used in any public or private datacenter as long as a user is properly licensed.
FSLogix tools operate on all Windows operating systems including:

e Desktop - Windows 7 or newer
e Server - Windows Server 2008 R2 or newer

FSLogix solutions support both 32-bit and 64-bit where applicable. These solutions are only supported in
environments that Microsoft, original software vendors, and equipment vendors support for their
application.

Note: Frame workloads are supported on Windows 10 for client OS and Windows Server 2016 or higher
at this time.

Profile Container

Profile Container is used to redirect the entire user profile in non-persistent, virtual environments, such
as Virtual Desktops. When using Profile Container, the entire user profile (except for data that is excluded
using the redirections.xml) is included in the profile container.

For users familiar with managing profiles in non-persistent environments, the function of Profile
Containers may be compared to Microsoft User Profile Disk, Liquidware ProfileUnity, Profile Disk and
Nutanix Frame Enterprise Profiles, or Citrix UPM. Although the function is similar, the underlying
method and technology is different, resulting in certain benefits as described.



Installation and Setup on Frame
The following details will address how to install and configure a Frame environment using FSLogix as a
third-party Windows user profile solution for user data persistence.

Test Environment Requirements:

v Single AHV Cluster with Prism Central
v Microsoft Active Directory Domain Controller 2016/2019 server
v File Server 2016/2019
o Central File share for Profiles
v Two Non-Persistent Frame Accounts
o Frame Guest Agent (FGA) v8.0.12.0 or higher
o AIR 8GB Instances
o Windows10 build 2004 & 20H2 tested
v A domain admin and a domain user account

Prerequisites
Before configuring Profile Container:

Verify that you meet all entitlement and configuration requirements

Download and install the latest FSLogix Software

Consider storage and network requirements for your users' profiles

Verify that your users have appropriate storage permissions where profiles will be placed
o Permissions required for secure roaming profiles & redirected folders

e Profile Container is installed and configured. Stop and remove other solutions intended to
manage remote profiles. Using multiple profile solutions concurrently can cause issues.

e Exclude the VHD(X) files for Profile Containers from antivirus (AV) scanning

Notes: Ensure Frame accounts are domain joined (including the Sandbox temporarily), that OFS is
configured for the Frame accounts (engineering enablement task), and that TimeFreeze is not in use (it
can be installed, but don’t use it).

Installation and Setup

1. Download and install the most recent FSLogix build.
a. https://docs.microsoft.com/en-us/fslogix/install-ht

2. Add the Sandbox to the domain (can be temporary to install and test FSLogix Profile Containers).
a. PowerShell: Add-Computer -DomainName dansdomain.com


https://aka.ms/fslogix/download
https://www.itpromentor.com/profile-permission/
https://docs.microsoft.com/en-us/fslogix/install-ht
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Note: FCP (Frame Credential Provider) will block domain join when using FGA v8.x.x Currently FCP limits
the use of UAC.

3. Login to the Sandbox with domain admin credentials.
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Define VHDx locations (e.g., \\dansdcO1\FSLogix on the DC)



Fﬂ Mew Share Wizard —
Specify share name
Select Profile Share name: FiLogix
Share Location
= Share description:
Qther Sattings
Local path to share:
Ch\Shares\FSLogix
0 If the folder does not exist, the folder is created.
Remote path to share:
WdansdcO1\FSLogix
Figure 5
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Figure 6

Note: Use FQDN and not the NetBIOS name. The FSLogix Agent works best with DNS.
a. Ensure permissions on FS are set correctly as per:
i. https://docs.microsoft.com/en-us/fslogix/fslogix-storage-config-ht
b. Add SYSTEM with Full Control permissions on the profiles folder.



https://docs.microsoft.com/en-us/fslogix/fslogix-storage-config-ht

c. VHD file format is only for Win7/Server2008, while VHDx is forWin10/Server2016+. Use

VHDX when possible so you can resize the VHDX- based VM.

6. Add the ‘Frame’ user and ‘Domain Admins’ to the exclusion list.
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7. Verify the ‘Altitude’ registry value for OFS via the Registry in:

HKLM\System\CCS\Services\OFS\Instances\OFS Instance - from 145600.6 to 100000 (6 x 0) Reboot
your Sandbox. This setting is required in order for FSLogix Profiles to work with Frame. If not

completed, initial profile creation will fail. Verify it’s as stated.

B Registry Editor

File Edit View Favorites Help
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OFS\Instances\OFS Instance
NetBIOS A || Name Type Data
NetbiosSmb ab| (Default) REG_SZ (value not set)
N ab| Altitude REG_SZ 145600.6
——— 24| Flags REG_DWORD 000000000 (0)
Netlogon
Netman
netprofm
NetSetupSve

Mat TrnD At Ch:

Figure 8




B Registry Editor
File Edit View Favorites Help
Computer\HKEY_LOCAL_MACHINE\SYSTEM CurrentControlSet\Services\ OF S\ Instances\OFS Instance

v [ OFs A || Name Type Data
w Instg:;:s ab| (Default) REG_SZ {value not set)
. t"m”ce ab| Altitude REG_SZ 100000
MR, 74| Flags REG_DWORD Dx 00000000 (0)
OneSyncSve
OneSyncSve_7535b4
Figure 9

a. Check OFS filter driver altitude via fltmc.exe from an administrative command prompt.
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8. (Optional) Frame strongly recommends that administrators leave the Sandbox on the Domain.

Leaving the Sandbox domain joined simplifies future management. However, if you must remove the
Sandbox from the Domain, follow the steps below:

a. Go to System properties; Advanced system settings

b. Select the Name tab.

System Properties X
Computer Name Hardware Advanced System Protection Remote

Windows uses the following information to identify your computer
== on the network.

Computer description:

For example: "Kitchen Computer” or "Mary's
Computer".

Full computer name: Laptop-PCOJUQTF

c. Select the Workgroup button and point to the workgroup of choice.

Computer Name/Domain Changes X l

You can change the name and the membership of this
computer. Changes might affect access to network resources.

Computer name:
IF-4E4DD1E493F5

Full computer name:
IF-4E4DD1E453F5 dansdomain.com

More...
Member of
() Domain:
(®) Workgroup:
WORKGROUP|
Cancel

d. Select OK.



Computer Name/Domain Changes

0 Welcome to the WORKGROUP workgroup.

Figure 12

9. Publish the Sandbox.

Dans FSLogix Acc Sandbox
ount One

Summary
Sandbox

Utility Servers

Launchpads
Users
Capacity
Analytics
Audit Trail
Notification center Last published on Mar 15th 2021 20:16
Settings
Status. Backups
Figure 13
Servers
Servers
Workload Id = Machine Name Public IP Private IP
5205387 IF-AEADDIE493F5 10.42192.113
5300159 NUTANIX-V3OPESF prod-32999-10-42-192-170.nut...  10.42192.470
Figure 14

PUBLISHING
prod-32999-10-42-192-113.nutanixframe.com
Nutanix-AHV, PHX-X-LABS_CCA30rc34

Air BGB

200 GB

Windows 10

8.0120

Create backup

VM Kind Instance Type Status
Sandbox ntx.plc2.m8 @® Stopped
Production ntx.plc2.m8 @® Almost ready

© Refresh

10. Log in to a desktop instance as a Domain User (not a Domain Admin). Make some changes to the

desktop ( e.g., create a folder). Close the session.



Figure 15

11. Log in to a new session and see if the change you made earlier persisted.

¥

Ll Type here to search o

Figure 16
12. Verify that a container exists on the file share you made to store the profile containers.
I = | FSLogix - O x
Home Share View v 0
- v P » ThisPC » Local Disk (C:) » Shares » FSLogix » v & Search FS.. 0
Mame - Date modified Type Size
7 Quick access
5-1-3-21-1260287371-489247367-1556140357-1115_danuser 3/16/2021 12:27PM  File folder
[ Desktop »
* Downloads -
Documents  #
[&] Pictures -
System32

Figure 17



FSLogix Application Masking & Frame
Application Masking

Overview

Application Masking

Application Masking can be used to manage user access of installed components and applications.
Application Masking may be used in both physical and virtual environments. It is most often applied to
manage non-persistent, virtual environments such as virtual desktops.

Prerequisites:

e Verify that Entitlement and other requirements are met

e |Install FSLogix on the Sandbox VM that will use Application Masking

e |Install Application Masking Rules Editor on the Sandbox VM that administrators will be using to
create rules

e Install all applications, printers, fonts, and other resources to be managed with Application
Masking on the Sandbox VM

e Apply any organization-specific configuration for intended environments

Resources
e |Implement Application Masking Tutorial - FSLogix
e How to Simpli entralized Image Managemen

Assignment Order
Assignments are executed from top to bottom.

Example: Consider if two assignments were made for the same Rule Set. The first assignment applies the
Rule Set to Everyone; the second assignment specifies that the Rule Set does NOT apply to Userl. In this
case, the Rule Set would apply to everyone except Userl.

If an administrator were to reverse the order of the assignments above, the Rule Set would apply to
Everyone without exclusion.

Managing Assignments
1. After creating rules and rule sets, select the desired rule and click “File>Manage Assignments.”


https://docs.microsoft.com/en-us/fslogix/implement-application-masking-tutorial#prerequisites
https://www.nutanix.com/blog/how-to-simplify-centralized-image-management-in-nutanix-frame-with-microsoft-app-masking
https://www.nutanix.com/blog/how-to-simplify-centralized-image-management-in-nutanix-frame-with-microsoft-app-masking

Rule Set:

Assignment Applies
& Everyone No

Set As Template Mowve Up Move Down Add Remove

() Rule Set does apply to user/group
() Rule Set does not apply to user/group

AD Reporting oK Cancel Apply

Click “Add,” then select the type of Assignment you want. To create a new Assignment:

2.1.  Select one or more Assignments and click “Remove” to delete Assignments.

2.2 Select one or more Assignments and click “Move up” or” Move Down” to arrange
Assignments as desired.

2.3. Use the radio buttons to specify whether or not the Rule Set applies, then click “Apply”
to apply the application to an entity. Whether or not an Assignment applies is
represented by the “Applies” column.



User Assignment

Group Assignment

Process Assignment

1 Select User

User:  |lser

Domair |Cnntnsn.cnm

Assignment:*@Contoso.com

Cancel
| Select Group X
Group: |Gr|:|L||J | F 3
Domait | Contoso.com| |
Assignment:*@Contoso.com
Cancel

® | Process — >
Enter the Path to the executable:
[ ] Apply to child processes
Cancel




Network Location Assignment

Computer Assignment

Directory Container Assignment

B | Network Location — X
Enter the IF address:
Cancel
B | Select Computer X
Compute |k:|:|m|:|uter | F A
Domail | Contoso.com |
Assignment:*@Contoso.com
Cancel
B | AD Distinguished .. ~ — X
Enter distinguished name string:
Cancel




Environment Variable Assignment

i+ Enter Environment Variable x

Environment Yariable:

Value:

From File oK Cancel

Note: Environment Variables must be present at sign-on. Rules created after sign-on will not be
supported.

Manage Rule Sets and Rules in Application Masking

Application Masking manages access to applications, fonts, and other resources based on criteria. The
Application Rules Editor is used to describe the resource to be managed. The editor is also used to define
rule criteria. For instance, an administrator would want GitHub to be hidden from an Accounting group.
Additional details can be found in Microsoft’s official documentation.

Things you can do with the Application Rules Editor:

e Create new Rule Sets
e Edit existing Rule Sets
® Manage the user and group assignments for Rule Sets
e Temporarily test Rule Sets
Rule Types

FSLogix supports the following 4 rule types:

1. Hiding Rule

Hides the desired resources using specified criteria.


https://docs.microsoft.com/en-us/fslogix/application-masking-rules-ht

Hiding Rule -

Object Name:
|bhject | 5

Object Type

@ File/ Registry Value
O Directory / Registry Key
O Printer

O Font

Comment:

|C0mment |

2. Redirect Rule
Causes the desired resource to be redirected as specified.

it Add Rule X
Redirection Rule -

Source:

“Suurce | —]

Destination:
|Destinatiun | =

Object Type
@ File [ Registry Value
O Directory / Registry Key

Copy Object

Comment:
|Cumment |
Cancel
3. App Container Rule

Redirects the desired resource onto a VHD.



i Add Rule

|App Container (VHD) F ~ |

Folder:

|F|:|Iu:ler

Disk file:

|Disk File

Comment:

|Cnmment

QK

Cancel

4. Specify Value Rule

Assigns a value for the desired resource.

i Add Rule

|Sp-eci'ﬁ_.r Value Rule -

Registry Value Name:

|‘-.falue

Data:

|Data

Comment:

|comment

QK

Cancel




Configure FSLogix Application Masking with Frame
1. Install Rule Editor, then run “FSLogixAppsRuleEditorSetup.exe” as an administrator.

[0 Name

# FSLogixAppslavaRuleEditorSetup
1% FSLogixAppsRuleEditorSetup
ﬂ( FSLegixAppsSetup

s Quick access

[l Desktop

o Download Now
¥ Downloads
© Uploads

= Documents

4

W W W N

&= Pictures
J! Music
B videos

@ OneDrive
[ This PC

=¥ Network

Create Application Masking Rules

Date modified ype Size

2/472021 %:09 PM Application 067 KB

asamnns ananes S

# Microsoft FSLogix Apps RuleEditor Setup — X

To continue with Microseft FSLogix Apps RuleEditor (English) installation, you must
accept the terms of the End-User License Agreement. To accept the agreement, click the
check box below.

MICROSOFT SOFTWARE LICENSE TERMS &
FSLogix Profile Container

FSLogix Office Container

FSLogix Java Version Control

FSI naix Annlication Maskina v

41 agree to the license terms and conditions

Install Close

Options

Figure 20

1. Run C:\Program Files\FSLogix\Apps\RuleEditor.exe, then run the Rule Editor as an administrator.

| =1 Manage Apps - m} X
Home Share View Application Tools o
« v < Local Disk (C:) » ProgramFiles » FSlogix » Apps v O 2 Search Apps
[&=] Pictures # ~ [ Name Date medified Type Size -
b Music CompiledRules 3/15/2021 1:23 PM File folder
B videos imageformats 3/15/2021 1:23 PM File folder
3/15/2021 1:23 il
& OneDrive platforms 3/15/2021 1:23 PM File folder
Rules 3/15/2021 1:23 PM File folder
& This PC #5 ConfigurationTool 12/15/2020 12:13 PM Application 1,084 KB
P 30 Objects 5] e 12/15/2020 12:13 PM Application 691 KB
[ Desktop [ freceds 12/15/2020 12:16 PM Application 1,216 KB
Dociinienis 4 frecontext 12/15/2020 12:16 PM Application 383 KB
[ frelauncher 12/15/2020 12:16 PM Application 202 KB
* Downloads . ~ o
. £ frushell 12/15/2020 12:16 PM Application 336 KB
d Music [ fresve 12/15/202012:16 PM Application 2,282 KB
=] Pictures il frctray 12/15/2020 12:16 PM Application 258 KB
m Videos (154 RuleEditor 12/15/2020 12:17 PM Application 2,506 KB
e Local Disk (C) cpprest_2_10.dll 12/15/202012:13 PM Application exten... 957 KB
: e %] d3dcompiler 47.d1l 3/11/2014 3:54 AM Application exten... 4077 KB L
34items  1item selected 2.44 MB =

Figure 21



2. Create Application Rules

FSLogix Apps RuleEditor
File Edit Help

D =

Filter Rules:

Figure 22

3. Name the file in your storage location.

ave File As

+ E] » ThisPC » Documents v O Search Documents »

Organize « MNew folder
~

O This PC A Name Date modified Type Size
J 3D Objects £ chrome
B Deckiop
@ Documents
* Downleads

J” Music

3/16/2021 1253 PM FSLogix Rule File 3KB

=] Pictures
n Videos
% Local Disk (C:)

¥ Network v

File name: | chrome

Save as type: | Rule Set File (*.fxr)

~ Hide Folders Cancel
Figure 24

Select the application you want to manage. Click “Scan” to have the Rules Editor detect the
application settings. When scanning is complete, Click “OK.”



Rule Set: Contoso_1 —

{) Blank Rule Set

() Enter Program Files Fath: =
@ Choose from installed programs:
[ © GitHub Desktop +
- GlobatProtect
[T Google Chrome
i‘* Google Earth Pro
[F GoTo Opener
[m7 GoToMeeting 8.44.2.13022
[®7 Intel(R) Dynamic Platform and Thermal Framework
(87 Intel(R) HID Event Filter
!l_'. Intel{R) Management En_gine Components o
Program Installation Directory:
|C:\Users\dcoombs\ﬂppData\Local\GitHubDesktop | —
Progress:
0%
Add Another Application Scan

F5Logix Apps RuleEditor

File Edit Help

b= & 7 + # 5 o

Filter Rules: |

Hiding Rule

Directory: %oProgramFilesFolder64%\Google\Chrome\Application
Product Install Directory

Hiding Rule

Appication uninstal key

Hiding Rule

Windows Instafer key

Hiding Rule
Key: HKLM\Software\Classes\Installer\Products|D44F598FFFDIA30308CE6916226E5738
Windows Instaler key

Hiding Rule
File: %SystemDriveFolderds\Users\Public\Desktop\Google Chrome.Ink
Frogram Shoricut (k)

Hiding Rule

Frogram Shoricut Lk}

Hiding Rule
File: %CommonStartMenuFolderyo)\Programs\Google Chrome.lnk
Program Shortcut (Lik)

Hiding Rule

Key: HKLM\SYSTEM\CurrentControlSet\Services\GoogleChromeElevationService
Key coniaining Service or Driver information

<

Key: HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\ { F895F44D-9DFF-303A-80EC-066122E67587

Key: HKLM' e \! \CurrentVersion\Installer\UserData\S-1-5-18\ Products | D44F598FFFD9)

File: %aSystemDriveFolder®s\Users\d. dmin\AppData\, ing \I ft\Internet Explorer\Quick Launch\Go«

Status: Ok (see status in Help->Status)

e

5. Assign masking method to rule (user here) to rule.




chrome
chrome iml
Rule Set:

Assignment Applies

‘ danuser@dansdomain.com Yes

‘ framesauser@dansdomain.com Yes

‘ Jonuser@dansdomain.com Yes aunchGo«

Set As Template Move Up Move Down Add Remove |

" Rule Set does apply to userjgroup -

" Rule Set does not apply to user/fgroup

Status: Ok (s|
AD Reporting oK Cancel Apply |

Figure 25

6. Apply rules to the system to verify status (see status warning below) select the checkbox option
again to remove applied rules.

FSLogix Apps RuleEditor — m} *
File Edit Help
|p = & v @ + = o
Filter Rules: | Apply Rules to S)rslemi
chrome | ermmrearn 7]
Key: HKLM\SOFTWARE\Classes\ChromeHTHL
Program ID
Hiding Rule
Key: HKLM\SYSTEM \CurrentControlSet\Services\GoogleChromeElevationService
Key containing Service or Driver informaion
Hiding Rule
File: %oCommonStartMenuFolder®s\Programs\Google Chrome.Ink
Program Shortcut (k)
Hiding Rule
File: %oSystemDriveFolders\Users\d imin\AppData\ ing\[ ft\Internet Exph \Quick Launch\Go«
Program Shortout (Jink)
Hiding Rule
File: %SystemDriveFolder®s\Users\Public\Desktop\Google Chrome.lnk
Program Shortcut (k)
Hiding Rule
Key: HKLM\Software\Classes\Installer\Products| D44F598FFFD9A30308(E6916226E5738
Windows Instaler key
Hiding Rule
Key: HKLM\Software\Microsoft\Windows\CurrentVersion\Installer\UserData\5-1-5-18\Products\| D44F598FFFD9)
Windows Instaler key
Hiding Rule
Key: HKLM\SOFTWARE | Microsoft\Windows\CurrentVersion\Uninstall\ { FB95F44D-9DFF-303A-80EC-966122E6758°
Appilcation uninstal key -
«| >
Status: Warning! Rule conflicts detected (see status in Help->Status) 4

Figure 26

7. Once you see Status: Ok in the lower left corner of the window, then unapply and save the rule.



FSLogix Apps RuleEditor - [} X
File Edit Help

| O = & z @ i a
Fiter Rules: | [2pply Rules to System]
— <]
Key: HKLM\SOFTWARE\Classes\ChromeHTML
Frogram ID
Conflict Detected - Hiding Rule
Key: HKLM\SYSTEM\CurrentControlSet)Services\GoogleChromeElevationService
Key containing Service or Oniver informadion
Hiding Rule
File: %%CommonStartMenuFolder® \Programs\Google Chrome.lnk
Program Shortcut (k)
Hiding Rule
File: %SystemDriveFolder¥s\Users\d: dmin\AppData\ ing\| ft\Ir Explorer\Quick LaunchGo«
Frogram Shoricut {Link)
Hiding Rule
File: %SystemDriveFolder%o\Users\Public\Desktop\Google Chrome.Ink
Program Shortcut (k)
Hiding Rule
Key: mu_M\Software\dasssursmler\Pmdm\mrsgsFFFngmsglsumns
Windows Insiafer
Hiding Rule
Key: IIICLH\Soﬂ'mre\Iﬁcmsoft\Wndows\CurrentVers»n\lnshler\UserDah\&l 5-18\Products\D44F598FFFD9)
Windows Insiafer
Hiding Rule
Key: IIICLM\,SOFI'WARE\M'l:rosdﬁ:\Wndows\CllrrentVersnn\UnnslaI\{FBBSFMD—QDFF -303A-80EC-96612JE6T58>
Application uninsial ke, -
<| 3

Status: Ok (see status in Help->5Status)

Figure 27

8. Once you have created the rules, exit the editor.

FSLogix Apps RuleEditor — O x
File Edit Help

| O = o

Filter Rules:

Hiding Rule =
firefox Directory: % ProgramFilesFolder64%:\Google\Chrome\Application
Product Instal Directory

Hiding Rule
Key: HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\ { FEO5F44D-9DFF-303A-80EC-966122E6 7587
Application uninstall key

Hiding Rule
Key: HI{I.M\,Software\chrosuft\Wndows\(urrentVers»n\,lnstzler\u‘serDah\,S—l -5-18\Products\D44F598FFFD9)
Windows Installer

Hiding Rule
Key: HKLM\Software\Classes\Installer\Products\D44F598FFFD9A30308CE6916226E5738
Windows Instaler key

Hiding Rule
File: %aSystemDriveFolder%o\Users\Public\Desktop\Google Chrome.Ink
Frogram Shorfout (Link)

Hiding Rule
File: %aSystemDriveFolderda\Users) in\AppData\ ing\| \Ir Explorer\Quick Launch\Got
Frogram Shortout (k)

Hiding Rule
File: %%aCommonStartMenuFolder®s\Programs\Google Chrome.Ink
Frogram Shortout (k) e

Hiding Rule
Key: HKLM\SOFTWARE\Classes\ChromeHTHML

Program ID -
| »

Figure 28

9. Copy rules from your source location into C:\Program Files\FSLogix\Apps\Rules.
Note: Two files of the same name exist for each rule each with adoffernat extension, .faxc & .fxc,
copy them all.



| 9 = | Rules — [} X

Home Share Wiew o
« v < Program Files » FSLogix » Apps » Rules v O Search Rules
&=/ Pictures # * [ Name Date modified Type Size
b Music & chrome 31 FSLogix Rule Assi... 1KB
& videos & chrome 31 FSLogix Rule File 2KB
) 3/ 71 1:02 PM ¢ Rule A 4
& OneDrive -‘f,- firefox 311 21 1:03 PM F5Logix Rule 1KB
3 firefox 31 02 PM F5Logix Rule File 2KB

Figure 29

10. Compiled rules will automatically be stored here: C:\Program Files\FSLogix\Apps\CompiledRules.

I & = | CompiledRules - m} X
Home Share View 0
« v 4 < Program Files » FSLogix » Apps > CompiledRules v O Search CompiledRules
=] Pictures # " [ Mame Date modified Size
b Music [ chromefrac 3/16/2021 1:10 PM 1KB
B videos [ chromefxc 3/16/2021 1:09 PM 2KB
- 3/16/2021 1:02 PM 4
& OneDrive [ firefox frac 3/16/2021 1:03 PM 1KB
|j firefou fuc 3/16/2021 1:02 PM 2KB
I This PC

Figure 30

11. Clear the “Quick access” (a.k.a. “recent files”) section in File Explorer in the Sandbox to ensure
they aren’t visible to end users.

CRRE| < | File Explore

4 & > Quickaccess

Share View

S Frequent folders (8)

Search Quick access

s Quick access
B Desktop ~ # Desktap Download Now Downloads
This PC d d This PC
© Download Ne# . D onedmn + 7
& Downloads  #
© siosd Uploads __ Documents Pictures
L o dan admin £ isPC == ThisPC
g £ * | S

-
[£) Documents #
= Pictures ~ #
D Music
B videos

Music

b This PC

Videos

m This PC

@ OneDrive ~ Recent files (2)

[ This PC =
¥ 3D Objects

B Desktop v
1 item selected 1014 bytes

This PC\Documents

This PC\Documents

10 items

Figure 31



wl = | File Explorer — o x
Home  ‘Share Edit with Microsaft FSLogix Apps RuleEditor [
. 8 Share with Skype
k O Search Quick access
T * Quickag Remove from Quick access o carch GQuick acee
~ : [& Edit with Notepad-++
= v
# Quick access EB Sean with Microsoft Defender...
B Desktop 12 Share ad Now Dewnloads
This PC
© Download Ne # Open with... " { by
& Downloads  # e e T >
Uolond i ) nts Pictures
Q Uploads  # Restore previous versions = jis PC
Documents  # —— > = .
[&] Pictures - z
opy
b Music
l Videos Create shortcut
) Open file location
@ OneDrive R
Properties
& This PC This PC\Documents
B 3D Objects This PC\Documents
I Desktop v
10items 1 item selected 1014 bytes

Figure 32

w | ] | = | FileExplorer - o x
Home  Share  View (2]
4 # > Quickaccess > v o P Search Quick access
~
# Quick access ~ Frequent folders (8}
B Desktop ~ # Desktop Download New Downloads
This PC dan ad This PC
© Download Ne # - o . ¥ o
¥ Downloads
Uslosd Uploads Documents Pictures
© Uplosds n dan admin This PC == TisPC
Documents Ny . * o
E Pidurs o Music Videos
B Music ﬁ This PC E This PC
B Videos
@ OneDrive ~ Recent files (0)

After you've opened some files, we'll show the most recent ones here.

I Desktop v
Sitems 1 item selected 0 bytes

Figure 33

12. Log off of the Sandbox.
13. Publish the Sandbox.



Frame

Dans FSLogix Acc Sandbox Start session
ount Two
PUBLISHING
Summary prod-33000-10-42-192-187nutanixframe.com
Sandad Nutanix-AHV, PHX-X-LABS CCA30rc34
Utility Servers
Air 8GB
Launchpads
Users 20068
Capaclty Windows 10
Analytics
80120
Audit Trail
Notification center Last published on Mar 15th 2021 20:07
Settings
Status Backups Create backup
Name Created At o Type
Backup request for vendor 33000 Mar 16th 202116:39E.. @)
Clone vendor, from vendor 32000 Mar 16th 202115:26 E.. ()
Created for DJI deployment at 2021-03-15 13:04:44 - backup generaliz.. Mar 15th 202116:04E.. (@)
Backup request for vendor 33000 Mar 15th 20211558 E.. (@)
Backup request for vendor 33000 Mar 15th 2021 16:41E.. (@)
Clone vendor, from vendor 33245 Mar 15th 20211540 E.. ()
Figure 34

14. Log in and test as a non-admin/end user to verify the rules are taking effect (mask Chrome and
Firefox.)

N Nextframe | Nutani

-l O Type here to search o &

Figure 35

Application Masking recommendations and options

® As a best practice, use one rule file set for each application suite (such a Microsoft Office).

e Device-based application (e.g. Visio/Project) masking is possible with Device-based licensing by
changing license parameters in rule editor. Be sure to add a Client name variable as part of the
rule.

e If you want to use masking conditions based on AD Groups, ensure that Sandbox & Frame
Account are set up to use Classic AD. As mentioned before, Classic AD is not required and you
may also use other masking rules besides users or groups.



Use Of FSLogix Group Policy Template Files

Overview
FSLogix relies on a set of registry keys to be enabled and correctly configured on the VMs. There are
several ways to apply these registry keys, depending on the scenario and scale of your environment:

e Manually creating registry keys using Windows Registry Editor:

o Itis not recommended since it is error-prone and potentially high risk. Manual effort is
required, and scale to many hosts is difficult. It should be used only for testing and

prototyping on a single machine.
® Local Policies:

o Itis possible to use the Group Policy Object (GPO) mechanism in Windows to apply a set
of configuration settings (registry keys) using an object stored locally on a single
computer. Should be used only for testing and development of GPO objects to be
applied on a larger scale using a Central Store.

o It can be used as a simple Sandbox master image management solution with Frame.

e Central Store for Policies:

o This approach is the recommended mechanism to apply FSLogix, and any other
configuration setting, at scale on all WVD Host Pool VMs. A centralized repository hosted
on Active Directory Domain Controllers is used, thus replicated throughout the entire
Active Directory domain.

Prerequisites

Local Policies and Central Store for Policies rely on a Windows feature called Group policy administrative
templates, also known as ADMX templates. The two files that you will need to copy to create your ADMX
template are fslogix.adml and fslogix.admx, which we will discuss in more detail below.

Note: In older versions of the FSLogix installation package, two additional and separate files have been
provided to configure the ADMX template for Office Container: FSLogixODFC.admx and
FSLogixODFC.adml. These files are no longer provided since all the contained settings are now inside a
single set of files, that is fslogix.adml and fslogix.admx.

ADMX Templates

Group policy administrative templates, also known as ADMX templates, include settings you can
configure for Windows machines through Group Policy Objects (GPO). Administrative Templates files are
divided into .admx files and language-specific .adml files. The changes that are implemented in these
files let administrators configure the same set of policies by using two languages. Administrators can
configure policies by using the language-specific .adml files and the language-neutral .admx files.

In order to facilitate GPO creation, administrators can import these templates and have the editor user
interface automatically configured with all the included settings. Once development of GPO is finished
with all the desired changes, the resulting GPO object can be associated (linked) to an Organization Unit
(OU) in Active Directory.



When VMs are created and joined to the Active Directory domain, the GPOs will automatically be
applied, and FSLogix will be configured.

Local Policy Settings

Local Policy Edit

It is possible to create and edit locally a GPO object using the same template files, in a production
environment it is recommended to use a Central Store. For completeness, here are the steps necessary
to use the template files locally:

1. Copy the ADMX file (fslogix.admx) to C:\Windows\PolicyDefinitions (and unblock the access to
the file in the file attribute)

2. Copy the ADML file (fslogix.adml) to C:\Windows\PolicyDefinitions\en-US (and unblock the
access to the file in the file attribute)

3. Run the “Local Group Policy Editor” tool (GPEDIT.MSC)

4. Browse to Computer Configuration thenAdministrative Templates then look for FSLogix
container.

5. Review and enable desired settings, then save the object.

File Action View Help
e 1@ =2 HE 7T

v Computer Configuration

| Software Settings Select an item to view its description.  Setting State Comment

| Cloud Cache
| Office 365 Containers

| Windows Settings

v || Administrative Templates
| Control Panel | Profile Containers
~ | FSlogix |z3)Enable logging: Driver interface Not configured No
| Cloud Cache \z@)Enable logging Not configured No

v [ Office 365 Containers

_| Advanced

| Cloud Cache

| Container and Directory Naming
v [ Profile Containers

- Advanced

| Cloud Cache

| Container and Directory Naming

Central Store

\z3)Enable search roaming

\i@)Enable logging: Office 365 container
|Z@)Enable logging: Rule compilation
\z@)Enable logging: Font visibility

%3)Path to logging files

|z@)Enable logging: Printer visibility
\zg)Enable logging: Windows search plugin

i Fnable loaaina: Active directorv comnuter aroun nrocessing

Not configured
Not configured
Not configured
Not configured
Not configured
Not configured
Not configured
Not confiaured

No
No
No
No
No
No
No
No

To take advantage of the benefits of .admx files, and to distribute settings automatically to the entire VM
production pools, you must create a Central Store in the Sysvol folder on a Windows domain controller.
The Central Store is a file location that is checked by the Group Policy tools by default.

The Group Policy tools use all .admx files that are in the Central Store. The files that are in the Central
Store are replicated to all domain controllers in the domain. To create a Central Store for .admx and
.adml files, create a new folder that is named PolicyDefinitions in the following location (for example) on

the domain controller:

e \\contoso.com\SYSVOL\contoso.com\policies\PolicyDefinitions

Now copy the FSLogix file fslogix.admx only into this location.



The PolicyDefinitions folder on the Windows domain controller stores all .admx files and .adml files for
all languages that are enabled on the client computers. The .adml files are stored in a language-specific
folder. For example, English (United States) files are stored in a folder that is named en-US. If not present
already, you will need to create a language-specific folder en-US, then add fslogix.adml inside.

Template Edit

In the previous section, you completed the preparation of the ADMX template specific for FSLogix for
your Active Directory domain. Now you are ready to use this template to create a GPO for your VM
production pool.

The administrative tools you will use are the Group Policy Object Editor and Group Policy Management
Console: these tools are already installed on Windows Server, they will require manual installation of an
additional package on a Windows client:

1.

6.

Sign in with a Domain Administrator account to a machine or VM part of your Active Directory
domain.

On Windows client OS, if necessary, install the "RSAT: Group Policy Management Tools":

2.1.  Open the Settings app > Apps > Optional features > Add features.

2.2. Select RSAT: Group Policy Management Tools > Install.

2.3.  Wait while Windows installs the feature.

On the admin computer, open the Group Policy Management app.

Locate your Organizational Unit (OU) where WVD Host Pool machine accounts are located, then
from the context menu select "Create a GPO in this domain, and Link it here...". Fill in a name for
the new GPO and press “OK”

Right-click on the newly created policy and select “Edit”, the Group Policy Management Editor
app opens.

Group Policy Management Editor e

File Action View Help

i 2 ] 7 Mol 4
MyNewFSLogixPolicy!  /M-DC DOM.LOCAL] Policy Setting State Comueat
|~ 8 Computer Configuration Advanced
Y. Il boboes Cloud Cache
Software Settings :
T Container and Directory Naming
| indows Settings -
| v [E| Administrative Templates: Policy definitions (ADMX files) retrieved from the central store, || LB Profile type Not configured No
| ) Store search database in profile container Not configured No
e 3)Set Outlook cached mode on successful container attach  Not configured No
e B e e %@ Enabled Not configured No
rr— [£)VHD location Not configured No
e [ Dynamic VHD(X) allocation Not configured No
| aotaines and Directory Naming ) Delete local profile when FSLogix Profile should apply Not configured No
| | " profile Containers @ Size in MBs Not configured No
Tanced

@) Allow concurrent user sessions Not configured No
Cloud Cache
Container and Directory Naming
Al Settings
Preferences
v & User Configuration
Policies
Preferences

Expand Computer configuration > Policies > Administrative Templates > FSLogix and enable the

desired settings for your configuration. Under the parent FSLogix folder, there are dedicated
sections for Cloud Cache, Office 365 Container, and Profile Container.



7. For each setting, double-click on it, enable, and eventually fill in the required values. At the end,
be sure to click on “Apply” to save and exit the dialog:

& VHD location

srf e Previous Setting Next Setting

O Not Configured Comment: Configure Azure Files Share repo for my Profile Containers)

(O Disabled

Supported on: FSLogix Profiles 2.5

Options: Help:

Specifies the network location where the VHD(X) files are stored.

VHD location e ‘ 3
For example, \\servername\share\ containers.

\\myazurefilesharelocation\sharel

8. Once finished, close the dialog and return to the main editor windows. At the next GPO refresh
cycle, the production pool VMs will receive these new policy settings and will apply to the local
machine registry configuration. If you want to expedite the process, you can connect locally to
the machine and execute the command below:

8.1. GPUPDATE /Target:Computer /force



General Profile Container and Application Masking Troubleshooting

Error Messages
The Error message below occurs when you are attempting to save the FSLogix configuration and the
Sandbox is not domain joined.

Saving general configuration

i > h Cannot modify 'FSLogix Profile Exclude List’ group
membership. Error code=1317

Figure 18

Usually when an FSLogix component is not working, Error will be set. When it is set, it corresponds to a
standard Windows Error Code.

https://docs.microsoft.com/en-us/windows/win32/debu
dfrom=MSDN

Logs

e The Log files are in %ProgramData\FSLogix\Logs\Profile
e C:\Program Files\FSLogix\Apps\Frxtray.exe (FSLogix icon tray) is an excellent way to get visibility
into the FSLogix profile and its status, configuration etc.


https://docs.microsoft.com/en-us/windows/win32/debug/system-error-codes--0-499-?redirectedfrom=MSDN
https://docs.microsoft.com/en-us/windows/win32/debug/system-error-codes--0-499-?redirectedfrom=MSDN

#fl FSLogix Profile Status

Events Configurabon took:

Adminstratve e I BT

— oo e Tested 22102 228k 1S -
Info Orign: C: Program Fies\FSLogix \Apps\ConfigurationTool. exe (Version 2.9.7654.46150)

WD Windows 10.0.19042 (Windows 10 Enterprise 64bit)

: [F-B5160E73F 149 User Name: Administrator
indox

User Profile: C:\Users\Administrator
Internet Explorer Pugn | brofie version: 6

Rule Editor Installed system RAM: 8191 M8 (oad: 29 %)
Java Rule Editor
Service FSLogix Service Version 2.9.7654.46150 Status: RUNNING
o FSLogix Kernel Driver Version 2.9.7654.45150 Status: RUNNING

ofie FSLogix Kernel Virtualization Driver Version 2.9.7654.46150 Status: RUNNING
Launcher
ODFC [14: 18:43. 104][6d:000003e0.0000 1394 [INFO] ===== Begin Session: Intiaization
Rule Compliation [14 m.-& 117] [ﬁ;momm.mlzw] [WARN: 00000000] Required key HKLM\SOFTWARE \FSLogix Profiles was not present and

successfully creat

Font [14: 18:43. 116] [6d:000003e0.0000 1354] [V ] No regstry key found: SOFTWARE \FSLogix Profies {Enabled
Network [14:18:43.116] ] No registry key found: SOFTWARE FSLogix Profies\VHDLocabons.
Printer ] No regstry key found: SOFTWARE \FSLogix Profies\VolumeType
Ads Computer Group ] No registry key found: SOFTWARE FSLogix Profies\SizelnMBls
Oriver Inkerface ] No registry key found: SOFTWARE FSLogix \ProfiesIsDynamic

] No regstry key found: SOFTWARE FSLogix \ProfiesLockedRetryCount

] No registry key found: SOFTWARE FSLogix Profies\LockedRetryinterval
= End Session: Initiakzation

AD Picker returned 1 dlements

b f0. LA AT I W T B AEASTIE 4 AR e

119] (60:000003¢0.00001394] [INFO]
. 744] [6d:0000030.0000 1394] [INFC]

a4 2 Fednnnn,

G e iog

Figure 19

By default, the profile container VHD will contain the entire Windows profile for the user, except for:

® The TEMP (TMP) folder location
e The IE Cache folder location

The Windows user profile is composed of the contents of a specific folder location and some registry
information. Typically this folder location is something like C:\Users\<username>.

If desired, the admin can specify that parts of the user profile are persisted in the profile container.
Exclusions are done with a redirections.xml file. The redirections.xml file instructs the FSLogix agent to
redirect specific folders out of the profile container and into the local C: drive. Any part of the profile that
is excluded will be deleted at sign-out. see the folding link for details:

Additional Tips

e Configuring Personal Drive together with the FSLogix Profile Container did not cause an issue,
verified via Disk Manager.

e |tis easy to map a drive letter to FSLogix Profile Container share and browse inside the container
for troubleshooting in the instance or Sandbox.

The Profile Container sets three values that represent the state of Profile Container or Office Container:

e Status
® Reason
e Error


https://docs.microsoft.com/en-us/fslogix/manage-profile-content-cncpt#redirectionsxml

Profile Container stores error values here:
e HKLM\Software\FSLogix\Profiles\Sessions<UserSID>
FSLogix Office Container stores error values in two places:

e HKLM\Software\Policies\FSLogixX\ODFC\Sessions<UserSID>
e HKCU\Software\FSLogix\ODFC\Sessions

If the Status is zero, the system is in a working state, and Reason will reflect the state.

e For example, if Status and Reason are both zero, then the FSLogix Container is attached and
working for this user.

Status Codes

Status codes can be found in Microsoft’s official documentation.

Group policies

Two group policies need to be set correctly, as described below:

To redirect internet and temporary files, the user needs permission to redirect the profile folder. You can
find the GPO by going through the menus:

e User Configuration > Administrative Templates > Desktop > Prohibit User from manually
redirecting Profile Folder

This gpo needs to be deactivated to get a value of zero. However, | noticed that the policy is not setting
the correct value (at least for me) and therefore, | set the value by a user REG gpo.

e HKCU\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer
e DisablePersonalDirChange REG_DWORD = 0x00000000

A favorite gpo with companies is removing the run entry from the start menu, but this will also prohibit
opening unc paths. With FSLogix, the redirection.xml file is downloaded from an unc share to the local
profile. Therefore the download of the redirection.xml file would be blocked, and the exclusions will not

apply.

e User Configuration > Administrative Templates > Start Menu and Taskbar > Remove Run menu
from Start Menu

Windows Search and Log Off

The Windows search, when active, can have open file handles to files in the user profile. Because of that,
the virtual disk cannot be unloaded and will cause an issue with the following user logon. The
workaround to this is to set up a task at logoff that restarts the Windows search. The restart would have
no impact on other users because the restart takes less than a second.

The following command will restart the Windows search service :


https://docs.microsoft.com/en-us/fslogix/fslogix-error-codes-reference#status-codes

Powershell.exe -NoLogo -NoProfile -NonInteractive Restart-Service
WSearch

System file access

Under certain conditions, the system keeps open file handles to the user profile and is more specific to
the user keyword store. The open handle will block an unload of the virtual disk and the profile gets
stuck at that server. There is an undocumented value CleanupinvalidSessions under
HKLM\Software\fslogix\apps that can be used with the current FSLogix Version 2.9.7802.10873 and
might help. If not, then you must restart the server!

Format of the Redirection File

It's important that the redirection file has no errors in the format or the xml syntax. If the file includes
errors, then this can lead to different behavior. The best indicator is the FSLogix eventlog, an event that
starts with "error.cpp(13)," and has become an alert for me. Often, then the vDisk cannot be unloaded
from the server.

Official Microsoft Documentation:
e FSLogix Release Notes

e Configure Profile Container Tutorial
® Storage Permissions for Profile Container and Office Container
e |Install FSLogix Agent

e Profile Container troubleshooting guide

e FSlogix Logging and Diagnostics

e Create FSLogix profile container Azure Files Active Directory Domain Services -

Azure

e Configure FSLogix Cloud Cache Tutorial

e Cloud Cache for resiliency and availability

Additional Resources:
e D A7-140ep07 | Plan FSLogix Storage
e D FSLogix S2E1 Configuring FSLogix Profiles and Office Containers for the ente...

e O FSLogix Application Masking - Advanced Hiding of Project and Visio


https://www.youtube.com/watch?v=tXVxuDbbNi4&feature=youtu.be
https://www.youtube.com/watch?v=Wv2vXMMg1GU
https://www.youtube.com/watch?v=opPTy9nUAwE
https://docs.microsoft.com/en-us/fslogix/whats-new
https://docs.microsoft.com/en-us/fslogix/configure-profile-container-tutorial
https://docs.microsoft.com/en-us/fslogix/fslogix-storage-config-ht
https://docs.microsoft.com/en-us/fslogix/install-ht
https://docs.microsoft.com/en-us/fslogix/fslogix-trouble-shooting-ht
https://docs.microsoft.com/en-us/fslogix/logging-diagnostics-reference
https://docs.microsoft.com/en-us/azure/virtual-desktop/create-profile-container-adds
https://docs.microsoft.com/en-us/azure/virtual-desktop/create-profile-container-adds
https://docs.microsoft.com/en-us/fslogix/configure-cloud-cache-tutorial
https://docs.microsoft.com/en-us/fslogix/cloud-cache-resiliency-availability-cncpt

e FSLogix/Invoke-FsIShrinkDisk - Shrinks FSLogix Profile and 0365 dynamically

expanding disk(s).


https://github.com/FSLogix/Invoke-FslShrinkDisk

